
Introduction

3DSimEd is an OpenGL application designed to help the process of  creating objects for a number of sims. The intention is to provide a solid, reliable tool 

which overcomes the problem of having to repeat work for each game.

. 

Quick UI Guide

Right click to edit faces, objects, or points, beneath the cursor (more details).

Hold down the left mouse button to rotate a drawing.

Hold down the shift key with the left button to move the light around the drawing.

To zoom use the mouse wheel, or the +/- keys on the numeric pad.

Double-click left mouse button to set the view center to the nearest point.

The arrow keys will move the camera left, right, forward and backward. The 'A' and 'Z' keys will move the camera up and down.

Ctrl key and left mouse gives a rectangular selection box. The faces and objects within the selection can be edit (more details).

The F1  key will give you context help.

Click here for help with the Ribbon Interface, 

Context Selection

If you right click on part of the drawing you will be presented with a context menu.

Memorize XYZ will record the location which you have clicked on. This can be recalled when editing points, objects, or creating primitives. A copy of the 

position is also placed on the clipboard to allow pasting into text editors.

Edit Point will be greyed out if you are not over a vertex of the model data. If you are over a vertex then you will be presented with the edit point dialog. 

You cannot select a vertex of an object as they are edited as one. To allow editing of an object vertex you will need to explode the object. 

Edit Face will be available if you have pointed to a face in the model data. The face dialog will be presented allowing you to modify or delete the face.

You cannot select a face within an object as objects are edited as one. To allow selection of an object face you will need to explode the object.

Edit <object name> will present you with the object dialog. 

Material <material name> will present you with the edit material dialog

Hide will present you with a sub-menu allowing either the object or material to be hidden.

Converting Between Sim Formats

In all the cases below you will probably need to convert the textures. Don't forgot to use Tools Texture Browser which includes a batch converter.

Single Object Conversion

For a single object this is very simple. Simply open with Import Model. To save use the relevant Savel command.

Multiple Object Conversion

Conversion of multiple objects is a little more complicated. 

1) Papyrus N2003 to Imagespace .MTS, rFactor .GMT or GTR .GMT. Open the track .PTF file with Open Model. Then for each of the formats use the relevant 

Save Objects command. You will be prompted for a save folder as multiple objects are going to be written to disk. A .PTF can contain many references to the 

same Object which is not the case for the other formats listed above so you may get a number of objects with a number appended.

2) Papyrus ICR2, N2, N3, NL, GPL to Imagespace .MTS, rFactor .GMT or GTR .GMT. The same as for .PTF above but open the main track .3DO with the 

Import Model command.

3) Creating Objects for Papyrus N2003 from previous Papyrus Sims.  Open the .PTF of the N2003 version with Import Model. From the older version open the 

main track .3DO with the Import Model command. Use Edit Copy All and Paste Objects to transfer the objects. Save all the objects with the Save as N2003 

Objects command. Finally use the Update .PTF command to ensure your objects are referenced in the .PTF.

4) Creating Objects for Papyrus N2003 from other sims. Open the N2003 .PTF file with Open Model. Open the objects you need using the Open Objects 
command. Copy and Paste these objects to the .PTF. Before saving the N2003 Objects with Save N2003 Objects, use the Edit Center Objects. Finally use the 

Update .PTF command to ensure your objects are referenced in the .PTF.

File New
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Simply creates a new blank scene.

Recent File

Allows a recent model or scene to be opened.

File Import

Imports a model from either a sim format or .3DS.

Below are some notes on the way 3DSimED imports these formats.

Note that model data means face and vertex data that can be directly edited. Object data is when the faces and vertexes of a drawing are grouped together 

for editing purposes.

.3ds Files|*.3ds|

Importing a 3DS file will result in a drawing with one or more objects.  To edit face data you will need to explode the objects.

3DO/PTF Files|*.3do;*.ptf|

Importing most .3DO files just gives you the model data as faces. However, if you import a track .3DO then all the objects within that track are also 

imported.

A .PTF file contains references to TSOs which will be imported. 3DSimED also generates a mesh to represent the walls and track surfaces. Please note this 

mesh does not exist in the .PTF and is just a graphical representation of the PTF. SimED will not Import a PTF from the tracks supplied with the game N2003.

rFactor GMT files|*.gmt|

The .GMT files is imported so that the model data can be edited.

rFactor SCN files |*.scn|

Reads the definition of the scene decompressing any .MAS files required. A temporary folder is created if any .MAS files are found and if you want to work 

with SimED's native format you should use the Export Textures and Save Model functions on the File Menu.

rFactor Veh files|*.veh|

Reads the complete definition of a vehicle and decompresses any .MAS files required. The GMT objects and textures are then read in. Importing a VEH file 

will probably cause SimED to create a temporary folder within the 3DSimED folder. If you need to save and work with the data you should use the Export 

Textures and Save Model functions on the File menu.

GTR GMT files|*.gmt|

A single GTR .GMT file is imported so that the model data can be edited.

F1-2001/2002 MTS files|*.mts|

The model data of a single F1CC/F1-2002/F1-2001 .MTS file is imported 

F1-2001/2002 SCN files|*.scn|

Reads the definition of the scene decompressing any .MAS files required. A temporary folder is created if any .MAS files are found and if you want to work 

with SimED's native format you should use the Export Textures and Save Model functions on the File Menu.

Nascar SimRacing MTS files|*.mts|

The model data of a single Nascar SimRacing .MTS file is imported.

Nascar SimRacing SCN files|*.scn|

Reads the definition of the scene decompressing any .MAS files required. A temporary folder is created if any .MAS files are found and if you want to work 

with SimED's native format you should use the Export Textures and Save Model functions on the File Menu.

Ford Racing 3 XBX |3dobjs.xbx|

All the objects within the 3dobjs.xbx are imported

Race Driver|*.P3D;*.px|

The model data of a single P3D or px file is imported. 3DSimED supports through to Race Driver 3

SuperBike Trk|*.trk|

The model data of a single SuperBike .trk file is imported.

3DV Files|*.3dv|

The model data of a single .3DV file is imported.

VRL Files|*.vrl|

The model data of a single VRL file is imported.

Expand GTR    
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Allows you to decompress a GTR file saving all the components archived within it.  

See Expand F1 .MAS for more information.

Tools Pack Files, rFactor .MAS, GTL .GTL, GTR .GTR

This function allows files to packed to various formats saving disk space.

The convention is to have two packed files, one containing all the objects and the other contained all the textures. For example, for rFactor you would pack 
all the .gmt objects to MyTrack.MAS and all the graphic files to MyTrackMap.MAS. You must make sure your scene file references these packed files. 

Note that 3DSimED does not delete files from disk, or in the pack, when packing and that the operation always adds the files you select to the packed file. If 

a file already exists in the pack then it will be replaced. 

Tools Expand Extract DDS

Extracts DDS files from GRID and DIRT .PSSG files. All DSS format textures found in the selected PSSG are written to the selected folder.

Tools Pack Update DDS in PSSG

Replaces the DDS files within a GRID or DIRT .PSSG file with the selected DDS files. If a selected DDS is not in the PSSG it is ignored.  If the DDS is not of 
the correct format there is a warning message and the DDS file is skipped.

Expand TOCA .BIG

Decompresses a TOCA .BIG file to the selected folder. Any .BIG files found within the parent are also decompressed to the chosen folder.

Expand F1 Mas

Expands a F1CC or F1-2002 .MAS file to a folder. The .MAS files are compressed archives of files used for tracks, cars , logos etc. 

After selecting a .MAS file to expand the destination folder must be selected:-

+

Note that, if more information about a folder is required, you can right-click on the folder name and you will be given a number of choices such as 'Explore'.

Confirm the folder selection  with OK and you then be asked to confirm the selections you have made so far are OK.  

Finally there is a prompt asking whether to overwrite files of the same name already residing in the destination folder.

Expand Papyrus .DAT

Decompresses a Papyrus .DAT file to the selected folder.

Expand Nascar Heat/Viper Racing .RES

Extracts all files contained within an .RES resource archive.

Tools Texture Browser

Allows you to browse textures.

The file types recognised include .MIP, .M16, MI4 (from the Papyrus sims) as well as .BMP, TGA and DDS. 

If a texture has transparency this is shown as magenta.

Note there are also options to allow conversion of single graphic files to other formats and a Batch Conversion tool.
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Load GLSL Shaders

This function allows GLSL Shaders to be completely switched-off. If you have a video card which is running GLSL Shaders very slowly you can use this 

function to make sure GLSL Shaders are never run by 3DSimED. Very slow frame-rates indicate that the video card is running a software emulation of GLSL 

Shading. It is very likely in that situation that a newer OpenGL driver will overcome the problem and this option could be switched on again. Alternatively, 

Fragment Programs can be used for shader rendering (see below).

 Load Fragment Programs

Use this function if the graphics card does not support GLSL or as an alternative to GLSL. If Fragment Programs are not used for shading then it is 

recommended that this option is set to off as it slows the opening of a new drawing page and introduces a greater risk of bugs. Note that this function only 
loads Fragment Programs to use them the Display->OpenGL Options->Fragment Programs must be set to on.

Double Buffering.

Double buffering gives a better quality display with less flicker. As it is possible that a video card may have problems with double-buffering this option is 
available. It is very unlikely that most users will ever need to use this function.

Open SimED Model

Opens a 3DSimED .3SE file for editing. 

Save SimED Model

Saves a 3DSimED .3SE file to disk. 

If any of the textures used by the Materials in the model are found to be in a relative path to the 3SE then you are prompted as ask whether relative paths of 

textures should be written rather than absolute paths. Relative paths are particularly useful when copying between machines or reading a .3SE over a 
network.

3SE files are native to SimED and are not read by any other applications.

Edit Object
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The Edit Object window is designed to make the editing of objects to be as simple as possible. When editing N2003 PTF files you will be presented with a 
more complex dialog (more details here)

Note the use of spin controls which can often be far easier to use than typing in the numbers directly. Once you have selected an edit box you can use the 

arrow keys, or the mouse wheel, to quickly increment or decrement values, you do not need to click on the arrows of the spin control.

Edit Object Controls

A. View commands control  the model view, details here.

B. Name of the object.

C. Duplicate checkbox - if ticked the leaves a copy of the object in its original position. This is a very useful when you are using the same object in a number 
of places.

D.  Next button selects the next object are discards any alterations.

E. Closes the window discarding any edits.

F. The XYZ coordinate of the object position. 

G. MS: Memory Store button  - stores the current XYZ coordinates. MR: Memory Recall button - recalls the stored XYZ coordinates.

H. Paste button reads text on the Clipboard and if it finds three numbers separated by spaces it will use those for the XYZ coordinates.

I. The Yaw, Roll and Pitch angles in degrees.

J. Flip button - a quick way to add 180 to the Yaw &  Upright button  - a quick way to set the roll and pitch to 0 and thus make the object stand upright.

K. Scale XYZ axis

L. Tags button allows tags associated with object to be edited, details here.

M. Centre button sets the geometric centre of the object to be at 0,0,0 and calculates the XYZ of the new position. The object will appear to be in exactly the 
same position but the new centre will allow the object to be rotated around it's axis.

N. Isolate button - opens a new object from the object in memory.

O. Open button - opens a new object from the original disk file.

P. Copy button - copies the present instance of the object to the clipboard. Following this with Edit->Paste Objects would paste one object, at the same 

location to another drawing.

Q. Paste button - pastes face data from the clipboard to the selected object.

R. Replace button - allows you to replace the object data with a different file object.

S. Delete button - deletes the selected instance of the object.

T. Flatten button - creates model data from an object. The model data cannot be saved for more details see here.

U. Explode button - creates model data from an object but deletes the object and the model data can be saved. For more details see here.

V. First button - forces the selected instance of an object to become the first object in the object list. Useful for sky objects, in conjunction with the Display 

Sky function.

Face Selection
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The Face Selection window gives you information about the currently selected face(s).

The first face displayed is the nearest to the user. To edit other selected Faces use the Next button.

A. The index of the presently selected Face in the data.

B. Name of the texture applied to the present Face.

C. Normal of the present Face.

D. For Models loaded from .PTF files this will give the segment to which the face belongs, click to display the Track Section Information wndow. segment.

E. Makes the next selected Face with feedback on the number of selected faces.

F. Opens the Modify Face window.

G. Reverses the direction of the present Face.

H. Adds a duplicated of the present Face to the Model data.

I. Deletes the present Face from the Model Data.

Edit Point

Note the use of spin controls which can often be far easier to use than typing in the numbers directly. Once you have selected an edit box you can use the 

arrow keys, or the mouse wheel, to quickly increment or decrement values, you do not need to click on the arrows of the spin control.

Edit Point Controls

A. The XYZ coordinate of the object position. 

B. Memory Store button  - stores the current XYZ coordinates.

C. Memory Recall button - recalls the stored XYZ coordinates.

D. When updating the point all other point selected will also be altered. The other points are moved by the same XYZ as the present point.

E. Updates the point in the model.

F.  Next button selects the next point are discards any alterations.

G. Closes the window discarding any edits.

H. View commands control  the model view, details here.

Import Objects
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This command allows you to import multiple models as Objects. Once opened you can edit the position, rotation etc of these objects

For most formats you will get one object for each file imported. Note that in the case of .3DS files these can have multiple objects.

File Import Options

DirectX .X Left Handed Coords

Most DirectX .X files use a left-handed coordinate system but it is possible for applications to export .X data with a right-handed coordinate system.

GPL:- Only high detail geometry

With this option on only the highest level of detail of GPL .3DO files will be imported, otherwise all levels of geometry will be imported.

GPL:- Double-sided materials

This option controls whether, when importing GPL .3DO files, the materials are set to double-sided or not.

Nascar N4...N2003:- Only high detail geometry

This option controls the level of detail imported from N2003 .3DO files. Switch off to import all levels of detail.

Nascar N4...N2003:- Include night geometry

Switch on if you want to import night geometry from N2003 .3DO files as well as day geometry.

Nascar N4...N2003:- .PTF longitudinal resolution

When a Nascar .PTF file is imported, the mesh generated for the track segments will have no face longer than this value, so a smaller value will give a 

smoother mesh.

Nascar N4...N2003:- .PTF Lateral resolution

When a Nascar .PTF file is imported, the mesh generated for the track segments will have no face wider than this value, so a smaller value will give a 

smoother mesh.

Nascar N4...N2003:- PTF Arc resolution.

When a Nascar .PTF file is imported the resolution of the mesh generated for corners is determined by this value. Use a small number for a smooth mesh. 

File Load Material Library

Loads the selected material library. Materials in the present drawn are updated if with those in the library if they have the same name.

File Save Material Library

Saves the materials in the current drawing to disk

File Recent Folder

The sub-menu gives a list of the recently accessed folders. Select from this list to make the folder the working folder.

Save Race 07 Model

Saves model data to RACE07 .GMT format. Note that this data does not include the objects within the scene. To save them you will need to use Save Race 07 

Objects

Race GMT Options

Lit at Night. Ensures the objects reflect light at night. You will not want this for some background objects.

Pivot Point. Used by some objects, such as steering wheels, to define a local axis. The MR and MS allow you to retrieve and save XYZ data to exchange it 

with other dialogs in 3DSimED.

LODin, LODout Define the closest and further distance an object is seen at.

Notes.

For the .GMT to be read by Race 07 you will need to make sure you have a GameData\Locations\Track folder within your Race 07 folder, an example might 

be 

Page 7 of 27Introduction

12/05/2011file:///O:/TEMP/~hh94B3.htm



"\Program Files\Steam\SteamApps\MyUserName\race 07\gamedata\locations\MyTrack"

Make sure you save to this folder for Race to find the .GMT.

Faces which are just solid colour are altered to use the texture named _rgbmap.tga  This is supplied with 3DSimEd.

Save Race 07 Objects

Saves the objects within the model to Race 07 .GMT format. 

A dialog prompt for the destination folder for the .GMT files.

There is also a prompt to ask whether to export hidden objects. If the response is 'No' then only visible objects will be exported.

Notes

For the .GMTs to be read by Race 07 you will need to make sure you have a GameData\Locations\Track folder within your Race 07 folder, an example might 

be 

"\Program Files\Steam\SteamApps\MyUserName\race 07\gamedata\locations\MyTrack"

Make sure you save to this folder for Race 07 to find the .GMTs.

Faces which are just solid colour are altered to use the texture named _rgbmap.tga  This is supplied with 3DSimEd.

Race 07 normally uses textures in .DDS format but it can also read .BMP or .TGA files.

Save Race Model

Saves model data to RACE .GMT format. Note that this data does not include the objects within the scene. To save them you will need to use Save Race 

Objects

Race GMT Options

Lit at Night. Ensures the objects reflect light at night. You will not want this for some background objects.

Pivot Point. Used by some objects, such as steering wheels, to define a local axis. The MR and MS allow you to retrieve and save XYZ data to exchange it 

with other dialogs in 3DSimED.

LODin, LODout Define the closest and further distance an object is seen at.

Notes.

For the .GMT to be read by Race you will need to make sure you have a GameData\Locations\Track folder within your Race folder, an example might be 

"\Program Files\Steam\SteamApps\MyUserName\race\gamedata\locations\MyTrack"

Make sure you save to this folder for Race to find the .GMT.

Faces which are just solid colour are altered to use the texture named _rgbmap.tga  This is supplied with 3DSimEd.

Race normally uses textures in .DDS format but it can also read .BMP or .TGA files.

If a texture has .BMP as its extension then the texture must be in either .BMP or .DDS format.
If a texture has .TGA as its extension then the texture must be in either .TGA or .DDS format.

When writing the GMT files 3DSimED changes the texture extension to .TGA if the extension is not .BMP, TGA or DDS.

Save Race Objects

Saves the objects within the model to Race .GMT format. 
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A dialog prompt for the destination folder for the .GMT files.

There is also a prompt to ask whether to export hidden objects. If the response is 'No' then only visible objects will be exported.

Notes

For the .GMTs to be read by Race you will need to make sure you have a GameData\Locations\Track folder within your Race folder, an example might be 

"\Program Files\Steam\SteamApps\MyUserName\race\gamedata\locations\MyTrack"

Make sure you save to this folder for Race to find the .GMTs.

Faces which are just solid colour are altered to use the texture named _rgbmap.tga  This is supplied with 3DSimEd.

Race normally uses textures in .DDS format but it can also read .BMP or .TGA files.

If a texture has .BMP as its extension then the texture must be in either .BMP or .DDS format.

If a texture has .TGA as its extension then the texture must be in either .TGA or .DDS format.

When writing the GMT files 3DSimED changes the texture extension to .TGA if the extension is not .BMP, TGA or DDS.

Save N2003 Model

Saves model data to N2003 .3DO format. Note that this data does not include the objects within the drawing. To save them you will need to use File::Save 

N2003 Objects

Faces which are just solid colour are altered to use the texture named _rgbmap.mip  This is supplied with 3DSimEd.

If the model data did not come from N2003 you will need to convert textures to N2003 .mip files. You can do this from Tools::Texture Browser

Race Weekend Only:- Model is tagged to be only displayed during practice or a race (not testing).

Always Seen:- Model data will be displayed from any distance (useful for objects such as infields)

Copy Over Textures:-  Copies and textures used by this model into the same folder as the saved .3DO. The texture are not converted to N2003 .mip 
format for which you will need to use Tools::Texture Browser

Save N2003 Objects

Saves the objects within the model to N2003 .3DO format. 

A dialog prompt for the destination path for the .3DOs.

There is also a prompt to ask whether to export hidden objects. If the response is 'No' then only visible objects will be exported.

Faces which are just solid colour are altered to use the texture named _rgbmap.mip  This is supplied with 3DSimEd.

If the model data did not come from N2003 you will need to convert textures to N2003 .mip files. You can do this from Tools::Texture Browser

Save F1 MTS Model

Saves model data to F1CC or F1-2002 .MTS format. Note that this data does not include the objects within the drawing. To save them you will need to use 

Save F1 Mts Objects

Faces which are just solid colour are altered to use the texture named _rgbmap.bmp  This is supplied with 3DSimEd.

F1CC and F1-2002 use textures in .TGA or .BMP format. If a texture has either of these extensions it's name remains unchanged otherwise the extension is 

altered to .BMP when saving. If you need to convert textures for use in F1CC or F1-2002 then you can do this from Tools::Texture Browser

Save F1 MTS Objects

Saves the objects within the scene to F1CC/F1-2002 .MTS format. 

A dialog prompt for the destination path for the .MTS files

Faces which are just solid colour are altered to use the texture named _rgbmap.bmp  This is supplied with 3DSimEd.

F1CC and F1-2002 use textures in .TGA or .BMP format. If a texture has either of these extensions it's name remains unchanged otherwise the extension is 

altered to .BMP when saving. If you need to convert textures for use in F1CC or F1-2002 then you can do this from Tools::Texture Browser

Save rFactor Model

Saves model data to rFactor .GMT format. Note that this data does not include the objects within the scene. To save them you will need to use Save rFactor 

Objects
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rFactor GMT Options

Lit at Night. Ensures the objects reflect light at night. You will not want this for some background objects.

Pivot Point. Used by some objects, such as steering wheels, to define a local axis. The MR and MS allow you to retrieve and save XYZ data to exchange it 

with other dialogs in 3DSimED.

LODin, LODout Define the closest and further distance an object is seen at.

Notes.

Faces which are just solid colour are altered to use the texture named _rgbmap.tga  This is supplied with 3DSimEd.

rFactor normally uses textures in .DDS format but it can also read .BMP or .TGA files.

If a texture has .BMP as its extension then the texture must be in either .BMP or .DDS format.

If a texture has .TGA as its extension then the texture must be in either .TGA or .DDS format.

When writing the GMT files 3DSimED changes the texture extension to .TGA if the extension is not .BMP, TGA or DDS.

Save rFactor Model, Add to .MAS

Adds the saved .GMT  to a selected .MAS file. The saved .GMT is not deleted.

Save rFactor Objects

Saves the objects within the model to rFactor .GMT format. 

A dialog prompt for the destination folder for the .GMT files.

There is also a prompt to ask whether to export hidden objects. If the response is 'No' then only visible objects will be exported.

Faces which are just solid colour are altered to use the texture named _rgbmap.tga  This is supplied with 3DSimEd.

rFactor normally uses textures in .DDS format but it can also read .BMP or .TGA files.

If a texture has .BMP as its extension then the texture must be in either .BMP or .DDS format.
If a texture has .TGA as its extension then the texture must be in either .TGA or .DDS format.

When writing the GMT files 3DSimED changes the texture extension to .TGA if the extension is not .BMP, TGA or DDS.

Save rFactor Objects, Add to .MAS

Will add the objects to a .MAS file. The objects are not deleted.

Save GTR Model

Saves model data to GTR .GMT format. Note that this data does not include the objects within the scene. To save them you will need to use Save GTR 

Objects

Faces which are just solid colour are altered to use the texture named _rgbmap.tga  This is supplied with 3DSimEd.

GTR normally uses textures in .DDS format but it can also read .BMP or .TGA files.

If a texture has .BMP as its extension then the texture must be in either .BMP or .DDS format.

If a texture has .TGA as its extension then the texture must be in either .TGA or .DDS format.

When writing the GMT files 3DSimED changes the texture extension to .TGA if the extension is not .BMP, TGA or DDS.

Save GTR Model, Add to .GTR

Adds the saved .GMT  to a selected .GTR  file. The saved .GMT is not deleted.

Save GTR Objects

Saves the objects within the model to GTR .GMT format. 

A dialog prompt for the destination folder for the .GMT files

There is also a prompt to ask whether to export hidden objects. If the response is 'No' then only visible objects will be exported.
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Faces which are just solid colour are altered to use the texture named _rgbmap.tga  This is supplied with 3DSimEd.

GTR normally uses textures in .DDS format but it can also read .BMP or .TGA files.
If a texture has .BMP as its extension then the texture must be in either .BMP or .DDS format.

If a texture has .TGA as its extension then the texture must be in either .TGA or .DDS format.

When writing the GMT files 3DSimED changes the texture extension to .TGA if the extension is not .BMP, TGA or DDS.

Save GTR Objects, Add to .GTR

Adds the saved .GMTs  to a selected .GTR file. The saved .GMTs are not deleted.

Save GT Legends Model

Saves model data to GT Legends .GMT format. Note that this data does not include the objects within the scene. To save them you will need to use Save GT 

Legends Objects

GTL GMT Options

Lit at Night. Ensures the objects reflect light at night. You will not want this for some background objects.

Pivot Point. Used by some objects, such as steering wheels, to define a local axis. The MR and MS allow you to retrieve and save XYZ data to exchange it 

with other dialogs in 3DSimED.

LODin, LODout Define the closest and further distance an object is seen at.

Notes.

Faces which are just solid colour are altered to use the texture named _rgbmap.tga  This is supplied with 3DSimEd.

GT Legends normally uses textures in .DDS format but it can also read .BMP or .TGA files.
If a texture has .BMP as its extension then the texture must be in either .BMP or .DDS format.

If a texture has .TGA as its extension then the texture must be in either .TGA or .DDS format.

When writing the GMT files 3DSimED changes the texture extension to .TGA if the extension is not .BMP, TGA or DDS.

Save GTL Model, Add to .GTL

Adds the saved .GMT  to a selected .GTL  file. The saved .GMT is not deleted.

Save GT Legends Objects

Saves the objects within the model to GT Legends .GMT format. 

A dialog prompt for the destination folder for the .GMT files

Faces which are just solid colour are altered to use the texture named _rgbmap.tga  This is supplied with 3DSimEd.

GT Legends normally uses textures in .DDS format but it can also read .BMP or .TGA files.

If a texture has .BMP as its extension then the texture must be in either .BMP or .DDS format.

If a texture has .TGA as its extension then the texture must be in either .TGA or .DDS format.

When writing the GMT files 3DSimED changes the texture extension to .TGA if the extension is not .BMP, TGA or DDS.

Save GT Legends Objects, Add to .GTL

Adds the saved .GMTs  to a selected .GTL file. The saved .GMTs are not deleted.

Save GTR2 Model

Saves model data to GTR2 .GMT format. Note that this data does not include the objects within the scene. To save them you will need to use Save GTR2 

Objects
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GTR2 GMT Options

Lit at Night. Ensures the objects reflect light at night. You will not want this for some background objects.

Pivot Point. Used by some objects, such as steering wheels, to define a local axis. The MR and MS allow you to retrieve and save XYZ data to exchange it 

with other dialogs in 3DSimED.

LODin, LODout Define the closest and further distance an object is seen at.

Notes.

Faces which are just solid colour are altered to use the texture named _rgbmap.tga  This is supplied with 3DSimEd.

GTR2 normally uses textures in .DDS format but it can also read .BMP or .TGA files.

If a texture has .BMP as its extension then the texture must be in either .BMP or .DDS format.

If a texture has .TGA as its extension then the texture must be in either .TGA or .DDS format.

When writing the GMT files 3DSimED changes the texture extension to .TGA if the extension is not .BMP, TGA or DDS.

Save GTR2 Model, Add to .GTR

Adds the saved .GMT  to a selected .GTR  file. The saved .GMT is not deleted.

Save GTR2 Objects

Saves the objects within the model to GTR2 .GMT format. 

A dialog prompt for the destination folder for the .GMT files

There is also a prompt to ask whether to export hidden objects. If the response is 'No' then only visible objects will be exported.

Faces which are just solid colour are altered to use the texture named _rgbmap.tga  This is supplied with 3DSimEd.

GTR2 normally uses textures in .DDS format but it can also read .BMP or .TGA files.
If a texture has .BMP as its extension then the texture must be in either .BMP or .DDS format.

If a texture has .TGA as its extension then the texture must be in either .TGA or .DDS format.

When writing the GMT files 3DSimED changes the texture extension to .TGA if the extension is not .BMP, TGA or DDS.

Save GTR2 Objects, Add to .GTL

Adds the saved .GMTs  to a selected .GTR file. The saved .GMTs are not deleted.

Save Model to NFS Shift MEB

Saves model data to NFS Shift .MEB format. MEB files are the component files for cars and tracks defining the visible geometry. Note that 3DSimED cannot 

create new materials for NFS Shift so when you save the .MEB you should ensure that the geometry only uses materials names that match those in the 

game. There is also no method of determining the different texture channels used by different materials and because of that it is quite possible that a saved 

unedited .MEB will not render exactly as it did before.

Update NFS Shift MEB

Updates only the XYZ coordinates in an existing .MEB. This function is useful if only small changes have been made as it preserves all texture channel and 

material information.

Save To Viper Racing

These functions export to Viper Racing format.

The .GRF files are used by Viper Racing tracks and can contain many objects.
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The .MOD files are used in Viper Racing cars and each .MOD is a separate object.

In addition, there is the option when exporting to either format to add the exported file to a Viper Racing resource.

Save To Nascar Heat

These functions export to Nascar Heat format.

The .GRF files are used by Nascar Heat tracks and can contain many objects.

The .MOD files are used in Nascar Heat cars and each .MOD is a separate object.

In addition, there is the option when exporting to either format, to add the exported file to a Nascar Heat resource.

Save As RBR

This function saves a model to Richard Burns Rally track format.

Note that you will need the RBR_RX.DLL which comes with Bob's Track Builder to allow a saved track  to be opened in RBR.

A dialog prompts for the track folder. This folder should be a sub-folder of RX_CONTENT and the meshes will be saved to the the XFILES sub-folder of this 
track folder.

The RBR Write Options dialog follows. The Update INI Files option controls the updating of the OBJECTLIST.INI and SPAWN.INI files. Normally you would 

want this option to ensure the OBJECTLIST.INI is updated with all objects and materials in the model while SPAWN.INI contains the start point & direction 

(the yaw angle is anti-clockwise, zero at east).

File Update Scene (SCN or TRK)

This function allows you to update a SCN (rFactor, F1-2002) or TRK (GTR, GTR2, GTL) without having to save the objects to disk. The tags associated with 

objects are updated, but no objects are saved.

It is very difficult to test the integrity of a .scn/.trk  file. As a result you should be careful with this function and you should make backups before saving. 

3DSimED automatically creates a backup for you with the extension .000 . 

Add Objects not found in Scene. This allows objects that are in the 3DSimED drawing, but not in the .scn/trk file to be added to the .scn or .trk file. 

Delete Objects in Scene but not in Model. If an object is found in the .scn/.trk but not in your present drawing it will be deleted from the .scn/.trk. As this 

object can remove objects from the .scn/.trk it defaults to un-checked which stops any objects from being deleted.

Note that the Lodin/Lodout and Lit at Night tags are saved in the objects so if you need to update these tags you must save the objects to disk.

File Update PTF

Updates the TSO list referenced by the PTF with the objects present in the drawing. Note that only the object position and orientation is saved to the .PTF. To 

save the objects to disk you will need to use File Save N2003 Objects.

Export GPL .3DO

Saves the Face data to GPL .3DO format. Objects are not included and will need to be Exploded if they are to be included
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Note that this function is intended for Trackside Objects not for the main track .3DOs

Faces which have been assigned the material "_GPL_COLLISION_MAT" will be used to determine the collision planes for the object.

If 3DSimED finds a material with this name it will try to write collision planes and the collision value will be prompted for. 

Export ASE23DO .ASE

This is similar to the Export GPL .3DO function but writes .ASE files which can be used by the ASE23DO.EXE utility to create .3DO files. Whichever of these 

two export functions gives the best result should be used.

Export Collada .DAE

Collada .DAE files are the recommended format for interchange with 3DS Max and Blender as the format has greater flexibility and less restrictions than 

the .3DS format.

When exporting to Collada format the complete model including objects is saved to one file. If any objects are hidden the use is prompted to ask whether to 
include those objects.

The user is also asked whether the Collada DAE file should use Windows pathnames which are required for Blender or ColladaMax (a 3DS Max plugin for 

reading and writing Collada files), otherwise the paths will be use the  URI file scheme.

SketchUp Export Options

After giving the filename, there is also a prompt to ask whether to export hidden objects. If the response is 'No' then only visible objects will be exported.

Smooth Edges

With this option on Sketchup will smooth the normals of adjacent faces, otherwise facet normals will be generated.

Soften Edges

With this option on Sketchup will try to group faces together as surfaces, otherwise all edges are hard and each face can be edited individually (which is what 
you would need if intending to edit texture coordinates, for example).

Exclude Sky Objects

Objects tagged as sky objects will be ignored.

Hide 'Not Rendered' Objects.

Objects tagged as 'Not Rendered' will be marked as hidden when the model is opened in SketchUp

File Save .3DS

Saves the complete drawing as a .3DS. 

8:3 Texture Names will shorten long texture map names to fit 8:3 in the same way as 3DSMax does when exporting .3DS. Similarly, object names are 
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shortened to 10 characters and material names to 16 characters. Make sure this option is switched on if exporting .3DS for 3DSMax.

Map solid colour faces is for handling faces with no material assigned and will ensure they are correctly coloured in the .3DS by using an _rgbmap.tga texture 
map.

Blender Compatible will not include object instancing information in the .3DS as Blender ignores instancing in a .3DS. For 3DSMax and most other external 

programs better results are achieved with instancing.

If when exporting to .3DS you have hidden any objects you will be promted asked whether to include them in .3DS. If you receive warnings that the vertex 

or face count is too large the written .3DS will be corrupt; the .3DS format has a maximum limit of 65536 vertices & faces for each object. 

Save As DirectX .X

Both functions save to text DirectX .X format. 

The Left Hand Coords option controls the coordinate system used for the .X file geometry which can be left or right handed.

The For Texture Maps include full path will either force the writing of full path names or simply the texture filename without the path.

Rename .DDS Textures to .TGA is useful for writing .X files which will be imported into applictions such as as Blender (which does not support .DDS).

The two Pre-set buttons make it easy to have the correct settings for Richard Burns Rally or Blender.

Save Single X File

All data is saved to a single .X file with one mesh for each object.

Write X File for each Object.

Each object is saved to a separate .X file.

Export GPS Data

This function exports a text file containing the XYZ data for the path of a track. The data is suitable for importing to Bob's Track Builder.

Note that for this function to be enabled you must have either imported a N4->N2003 .PTF or a GPL track .3DO or a ISI format scene with a .AIW present 
with the same root name as that scene. ISI format scenes are present in F1-20002, F1-CC, GTR, GTR2, and rFactor.

File Save DXF

File Export Textures

Allows you to save all texture maps present in the drawing to the same folder. 

Note you are also prompted as to whether the texture maps should be renamed in the drawing. If in doubt, just reply 'Yes'.

Primitive Upright

Primitives New Rectangle

Adds a new rectangle to the drawing data. 

Enter the position and dimensions of the rectangle in the dialog. Before the rectangle is added to the drawing you will be present with the group dialog which 
will allow you to transform the faces as if they are in an object. Note that the group dialog also allows you to choose to add the rectangle as an object instead 

of as faces.

Primitives New Box

Adds a new Box to the drawing data. 

Enter the position and dimensions of the Box in the dialog. Before the Box is added to the drawing you will be present with the group dialog which will allow 

you to transform the faces as if they are in an object. Note that the group dialog also allows you to choose to add the Box as an object instead of as faces.
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Primitive Sphere

Primitives New Cylinder

Adds a new Cylinder to the drawing data. 

Enter the position and dimensions of the Cylinder in the dialog. Before the Cylinder is added to the drawing you will be present with the group dialog which 

will allow you to transform the faces as if they are in an object. Note that the group dialog also allows you to choose to add the Cylinder as an object instead 
of as faces.

Primitives Add Object

Use this function to add objects on disk. You can add objects from a wide range of sims or SimED's native 3SE format. Once the object has been selected you 

will be presented with the Edit Object dialog.

Edit Undo

Edit undo restores the state of the last face(s), object(s) or point(s) edited. 

For example, if you have just moved the position of an object, Undo will take that object back to it's starting state not just the state before the last edit. 

Edit Select All Displayed

Selects all faces and objects presently displayed. This function uses the Display->Material Filter and Display->Object Filter settings to determine which faces 

and objects to select. For example, if the material filter is set to display only the material grass, all objects containing that material are selected. Note that 
geometry outside the present view will also be selected.

The sub-menus which follow are identical in both Edit Select All Displayed and Multiple Selection (CTRL + left mouse button).

Selection Sub-Menu.

A sub-menu is presented offering the choice to modify the face data or the objects selected.

Face Sub-Menu

Replace Materials will assign the chosen material to all faces in the selection.

Erase deletes all the faces in the selection.

Crop deletes all the faces outside the selection.

Copy replaces the faces on the internal clipboard with the selected faces.

Cut is equivalent to Copy followed by Erase.

Reverse Face reverses the direction the faces are pointing. After this operation one of the Edit->Normal functions should be used to correct the normals

.

Object Sub-Menu

Hide simply hides the objects.

Erase deletes the objects.

Copy replaces the objects on the internal clipboard with those selected.

Facet Normals recalculates the normals within the selected objects with facet normals.

Smooth Vertex Normals replaces all the normals within the selected objects with smoothed normals.

Up Normals replaces all the normals within the selected objects with normals that point up the z axis
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Set Tags sets the attribute tags for the objects. See the Object Tag help for more details.

Edit Select Geometry At Centre

A quick way to select the faces and objects at the centre of the display. Identical to placing the mouse at the centre and right-clicking the mouse.

Edit Previous Face

Re-selects the last face selected for editing. 

Edit Previous Object

Re-selects the last object selected for editing.

Edit Resize

Resizes the faces/polygons of the model data (but not the objects in model).

Edit Translate Model

Translates the model data and object positions by the XYZ entered in the dialog.

Edit Rotate Model

Rotates the model data by the angles entered in the dialog. The rotation of objects remains unchanged.

Edit Mirror Model

Mirrors the model data about the chosen axes. Note that you may need to re-work the texture coordinates after a mirror. To do this use the Material Editor 

Re-scale Texture coordinates function.

Edit Normals

Facet Normals

Every vertex of every face is given a normal and that normal is determined by the face normal. This causes every edge in the model to be hard.

Smooth By Group

Smoothing groups are used to calculate the normals.  If faces share a smoothing group then the edges between them will be smooth, otherwise the edge will 

be hard.

Models imported from .3DS, .GMT and Wavefront .OBJ have smoothing groups.

Smooth All

Vertexes shared by faces also have shared normals so every edge in the model in smooth.

Auto Smooth

For an edge to be smooth the angle between two faces must be less than the smoothing angle otherwise the edge will be hard.

Up Normals

Replaces calculated normals with normals that point up the z axis. This is useful for 'far-away' objects such as rows of trees and all edges will be smooth.

Edit Centre Model

Moves the model data so that it is centred at 0,0 with the bottom of the model sitting on the plane z=0.

Edit Centre Objects

Re-calculates the coordinate data within all the objects so that each object is centred at 0,0. This is useful for preparing objects that need to be saved to 

N2003 format.

Material Edit
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For a comparison of how 3DSimED uses the material properties see the table Material Variables in Export Formats

A. You can edit the material name. 

B. Hilights the material in the drawing.

C. Takes you to the Texture Browser allowing you to preview/change the texture map for the material. A better term for this texture is the diffuse map.  For 

completeness, the diffuse RGB can also be edited but it is rarely used in sim formats.

D. Sets the transparency of the texture map. Use this to override SimED's automatic determination of the transparency of a texture map.

E. The alpha of the material. Normally the alpha channe of a texture map is used to give the appearance of transparency.

F. Texture Mipmapping Bias. Controls the level of mipmap when rendering. Mipmaps are the levels of detail usually included in a texture map. A positive 
number will force the material to be rendered with lower level of detail. Negative values will cause the the material to be rendered with higher level of detail. 

G. Switches on/off Mip-mapping. Switch to off if only the top level of the texture is to be displayed.

H. Chroma RGB the transparent RGB if using 'Simple Transparency'.

I. Allows the Vertex Blending for the material to be set. This will control how the blending factor at each vertex which will be used by shaders that blend 

diffuse maps.

J. ReScale Tex will present the Re-Scale Texture Dialog allowing texture coordinates to be altered. Beneath the selected shader there is a longer description 

whenever appropriate.

K. No Clip. Faces in this material are not clipped and everything is drawn over them They are background materials and only have a meaning for ISI format 

sims.

L. Double Sided. Faces, using this material, are to be seen from both sides.

M. Render Target materials are special materials which can have other texture maps drawn over them, Only used in rFactor at present.

N. Glass materials are drawn last after the shadows cast by faces of other materials. Note that this attribute is not correctly rendered in 3DSimED.

P. The shininess of a material from 1 to 100. Higher values cause the material to reflect more of the light while small values will concentrate the reflection to 

a small spotlight.

Q. The specular RGB of the material. To use the specular colour when there is no specular map tick the check box. Note that the colours within a specular 
map are always multiplied by the specular RGB when rendering. 

R. The emissive RGB of the material. 

S. Shader. Allows the shader for the material to be edited. The drop list gives a short description of each available shader. 

T. Allows extra texture map(s) required by the shader to be selected. The caption indicates the type of texture map and the button is disabled if no map is 

required.

U. Controls the bias of the texture map.

V. Tex Coords. Allow the texture coordinates for the texture map to be changed. Note that these coordinates are stored in a separate channel for each 
texture map.

Page 18 of 27Introduction

12/05/2011file:///O:/TEMP/~hh94B3.htm



W. Animation is only for ISI format sims.  Movie animation is for .BIK movies. 3DSimED cannot play .BIK animations.  Cycle animations are continuous,  
Cycle Skip 0 skips the first frame until the animation stops - then it holds, One shot plays the sequence once, Pendulum also goes back through the 

sequence, Transient plays once and then the material is not displayed, Event animations have special names to trigger the animation, and Lerp animations 

are special animations used to control sky transitions.

X. The speed of the animation is controlled by the frequency (frames per second). 

Y. The animation sequence is a string of digits separated by commas. The digits are used to determine the names of the texture maps. For example, a string 

set to '0,1,2,1,3' with a diffuse map name of flag.dds would cycle the following sequence:- flag00.dds,  flag01.dds, flag02.dds,flag01.dds, flag03.dds. 

Z. Blend gives the blend of a cube map with the diffuse map when there are only two maps.

Edit Replace Material

Select the material which is to be replaced. The 'Select geometry with no material' allows geometry which has no material to be assigned a material. 

 Note that this function replaces materials in objects as well as face data.

Edit Erase Material Geometry
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This function allows you do delete all geometry assigned to a material including those in objects. The dialog allows for multiple selection of materials.

The 'Select geometry with no material' button will delete geometry which has no material assigned.

After using this function you may want to purge the material from the material list see Edit->Purge Unused Materials.

Edit Reset Material Transparencies

Resets all the material transparencies using the alpha levels from the textures assigned to each material to determine the material transparency.

Edit Copy All

Copies all the data within a drawing to an internal clipboard. Note this data is not available to other applications.

Edit Paste Objects

Pastes objects from the internal clipboard to the present drawing.

Edit Paste Faces

Pastes faces from the internal clipboard to the present model.

Paste Materials

Pastes only the materials that were previously copied to the clipboard. Clipboard materials overwrite those in the drawing.

Edit Paste Vertices

Pastes vertices from the internal clipboard to the local model data.  If the number of vertices on the clipboard is different from that of the local data then the 

number pasted will be the smallest of the two counts.

Use the option dialog to choose which attributes of the vertices should be replaced with those from the clipboard. In the above example the UV channels 2 

and 3 are not pasted and note that the texture coordinates of channels 0 and 1 will only be pasted if defined in the clipboard data; otherwise they will be 

ignored.

This function is particulary useful when working, for example, with NFS Shift damage .meb files. By using Edit->Copy All and Edit->Paste Vertices to the 

corresponding model that has no damage the damage can be revealed.

Edit Paste to Channel 1, 2 or 3

Allows the texture coordinates UV Channel 0, on the internal clipboard, to be pasted to the UV channel of choice. 

If the number of vertices on the clipboard is different from that of the local data then the number pasted will be the smallest of the two counts.

Explode All

Edit Paste Vertices Dialog
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Explodes all objects to face data. Objects within objects are also exploded until there are no objects and all data has become face data.

Purge Unused Objects

Removes all unused objects from memory. 

Purge Unused Materials

Removes all materials not  used in the drawing. 

Purge Duplicate Points

Removes duplicated points to minimize the storage required for the geometry. 

Note that identical points in different objects are not purged only duplicates within the same object.

Purge Empty Triangles

Removes triangles which have two identical vertices.  These triangles can cause problems for functions such as Smooth Vertex Normals.

View  Elevation

Plan Elevation

The view from above the scene (EW 0 NS 90).

Front Elevation

The view from the front of the scene (EW 0 NS 0)

Back Elevation

The view from the back of the scene (EW 180, NS 0)

Right Elevation

The view from the right of the scene (EW 90, NS 0)

Left Elevation

The view from the left of the scene (EW -90, NS 0)

Bottom Elevation

The view from underneath the scene (EW 0, NS -90)

View Set View

A dialog is presented which allows the view to be set manually. 

This is the dialog when working with a GPL track or N2003 .PTF. With other models you will get a simpler dialog without the Longitude, Latitude, and 

Elevation.

The Paste Pos takes clipboard text from the Memory Store function of other dialogs to set the position of the view centre. You can also copy text from the LLE 

Text field of a TrkMaker Material table and use the Paste Pos button to set the view centre.

View Reset View

Resets the view centre to 0,0,0 and angles to EW 30 degrees NS 30 degrees. The zoom is set according to the extents of the scene.
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View Eye Viewing

This command toggles Eye Viewing.

In Eye Viewing the camera is placed at the view centre and double-clicking the mouse will define a new position for the camera. The arrow keys will move 

the camera left, right, forward and backwards. Use the A amd Z keys to move the camera up and down.

To return to the usual view with the camera looking at the view centre just select Eye Viewing again.

View Walk Viewing.

This command toggles Walk Viewing. 

With walk viewing the camera will walk the track. The forward and back arrow keys take you along the track while the left and right keys move you across 

the track. Use the A and Z keys to move the camera up and down.

To return to the usual view with the camera looking at the view centre just select Walk Viewing again.

Note: This function is only available if you have opened a N2003 .PTF (with a RACE.LP in the same folder) or a rFactor/GTR/GTL/F1-2002/F1-CC .SCN file 
with a .AIW file in the same folder.

View Object

The dialog lists all objects presently displayed in the model.

When an object is chosen from the list, the view changes and the object is highlighted in cyan.

The object selected will be the new view centre. Either choose from the list and select OK or double-click.

To Edit the object use the Select function which will centre the view on the object and display the Edit Object dialog box.

Display Wireframe

Simply displays a wireframe view of the model.

Display Flat Faces

Displays faces filled with colour without textures.

Display Textures

Model is displayed with faces rendered with textures. Faces with no textures assigned, or with the texture missing are rendered as flat shaded in colour.

Display Show Animations

Toggle the display of animations for material. The rendering of animations can cause short delays, or stutters, while using 3DSimED so using this option cam 

help with editing when there is no need to see the animations.

Display Lighting

The equivalent of shining a light on the faces and objects. 

 This function is useful when attempting to find faces which may be facing in the wrong direction.

Display Object Filter
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 A list of the model objects is presented to the user. Select which objects you wish to display. 

The Select By Tag options are useful when editing an ISI format model that has been imported as a scene or  vehicle.

Switch Off if NOT allows objects to be hidden which do not match the selected tag.

Note this function also changes which objects can be selected with the mouse right button and Edit->Select All Displayed..

Display Un-Hide

Switches on the display of the last object or material hidden with the right button menu. 

Display Track Section

This function is only available when editing Papyrus tracks. It allows you to choose a section of the track to display. 

Display Material Filter

 A list of the materials present in the model is presented to the user. Select which materials you wish to display. 

Note this function also changes which faces and objects can be selected with the mouse right button.

Display Culling

Allows you to switch off faces depending on whether they are front or back facing.

Back Face

Switches off back facing faces. If you are looking from in front of an object and faces you want to see are turned off by back face culling then you need to 

reverse the face (see Face Selection)

Note this is also useful as a filter when editing data. All back facing faces are not selectable with this switched-on.

Front Face

Switches off front facing faces, hence you should see no front facing faces when looking from in front of your model. If you see faces which should be back 

facing these need reversing (see Face Selection)

Note this is also useful as a filter when editing data. All front facing faces are not selectable with this switched-on.

Display Reload Textures

Reloads all textures in the model. Use this function to see textures you have modified since the model was opened.

Display Colours and Fog
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Colours

This dialog allows the background, diffuse light, and ambient light colours to be changed.

Clicking on the colour boxes for Background, Diffuse Light and Ambient Light, will give the standard Windows Colour Common Dialog allowing customs 

colours to be assigned.

There are also four colour presets to choose from. Note that the Default button will restore the background colour as well as the diffuse & ambient light 

colours while the other three presets will only change the diffuse & ambient light colours.

Fog

Fog is a feature you may want to use when creating screenshots. The background colour is used as the fog colour. In normal viewing the fog will start at the 

near distance from the centre of the view and at the far distance the fog will be 100%. In eye or walk viewing the near and far distances are from the 
camera.

Fog is not enabled by default as it can hide objects you want to edit. 

Display XYZ Axis

Toggles the display of the XYZ axis. 

Display Sky No Z Depth

Renders sky objects behind all the other objects in the scene, which can be particularly useful when using Eye or Walk Viewing.

For this to work materials in the sky object must be marked as 'No Clip' and the sky object should be the first object to be drawn in the scene. When 

importing from rFactor, GTL, GTR2, Race and Race 07 3DSimED will order objects to make sure the sky is drawn first and you should find that the materials 
have been tagged as 'No Clip'. 

If an object needs to be forced to be the first drawn then use the Edit Object dialog to make the object 'First'.

Display OpenGL Options GLSL Shader Rendering

Switches on and off GLSL Shader rendering. GLSL Shaders give a better quality render but at the expense of frame-rate. You may want to switch Shader 

rendering off while editing large models to have faster rendering. This option will be greyed out if your video card does not support OpenGL GLSL Shaders. 

Display OpenGL Options Fragment Program Rendering

Switches on and off Fragment Program rendering which is an alternative to GLSL Shader rendering. Some video cards may support Fragment Programs but 

not GLSL. As with GLSL Shaders the rendering will be of a higher quality but at the expense of frame-rate. 

To use Fragment Programs switch on the loading of Fragment Programs with Home->OpenGL Options->Load Fragment Programs.

Display OpenGL Options Occlusion Queries

3DSimED uses occlusion queries to give better frame-rates with large models. Hidden objects within a model are clipped out saving rendering time. If it 

appears that objects are being incorrectly clipped out from the display you should switch this option off. 

Display Selection Options

These options control the way OpenGL is called when selecting geometry. 

One Pass

The preferred 3DSimED method.

The selection buffer is built in the same pass as the displayed geometry. The selection will include any geometry beneath the cursor.
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Two Pass

An alternative method if One Pass is proving to be too slow, for some graphic cards this may prove quicker than the One Pass  but for many graphic cards it 

will prove slower than One Pass.

The selection buffer is built in a separate pass to the displayed geometry. The selection will include any geometry beneath the cursor.

Quick

A solution if One Pass or Two Pass are slow.

A completely different method is used by 3DSimED to find geometry under the cursor. This method should be fast on all graphic cards but only the top visible 
geometry can be selected - there is no depth to the selection, hence no geometry hidden by the foreground selection will be found. For Quick selection to 

work correctly you may need to change the display settings so that the colour depth is 32 bits.  Also, if you have Double Buffering switched off you will get 

flicker when using this option.

Expand rFactor .MAS

Allows you to decompress a rFactor .GMT  file saving all the components archived within it.  

See Expand F1 .MAS for more information.

Expand Nascar SimRacing .MAS

Allows you to decompress a Nascar SimRacing .MAS file saving all the components archived within it.  

See Expand F1 .MAS for more information.

Texture Map Conversion

This function allows all texture maps in the current model to be converted to another texture format. The user is prompted for the path and the type of 

texture map to convert to. 

When the conversion is completed all the materials in the model will refer to the converted texture maps.

Direct Convert

The direct convert functions allow .GMT files in rFactor format to be directly converted to other similar .GMT formats suitable for GTL, GTR2, and Race 07. 

This can be useful for those who have originated rFactor models in 3DSMax and exported them using the GMT plugin. The advantage of these functions is 
that attributes such as normals, numbers of triangles etc are left untouched. The disadvantage is that material names may need to be altered; to allow for 

this, a material mapping function is provided. 

Direct Convert, To GTL, GTR2 or Race 07

3DSimED converts the original rFactor .GMT files for the objects presently imported. The user is prompted for a destination folder for the converted .GMT 

files. The .GMT files found on disk are directly converted to the chosen format.

Direct Convert .GMT files, To GTL, GTR2 or Race 07

The user is prompted for the rFactor files to be converted and then a destination folder for the converted .GMT files. The .GMT files selected are directly 

converted to the chosen format.

Material Mapping

This dialog allows the user to change the mapping of material names for Direct Conversions.

The left-hand names are the rFactor material name prefixes and the right-hand names are the new prefixes in GTL, GTR2 or Race 07. For example, using the 

table below a material named ovalrdpit in rFactor will be named concpit after the direct conversion. These material names are particularly important for 

track materials, and while 3DSimED's default mapping should work it's definitely worth spending some time looking at the material naming for the different 

sims.

Tools Reports

Various useful reports on the present model are sent to a notepad like dialog. This dialog allows simple editing and the ability to save a report to disk.
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Help OpenGL Diagnostics

This function can help to determine display problems. 

3DSimED uses many OpenGL extensions for rendering although it should be perfectly useable even if no extensions are available. 

A modern 3D card should show a complete list, as below.

If  your card has no extensions available then it is very likely that for some reason an OpenGL driver for the video card is not available on your system.

Activation 

3DSimED requires activation if it is to be used for longer than 20 days. 

The Activation dialog gives the user a way to request and enter an activation code.

Model Info gives a summary of the number of faces and vertices in the model as well as information on every object used in a model.

The Missing Textures and Objects report can be very useful for diagonising problems with a model loading in a game as it can determine which 

resources are missing.

Textures and Object Used is simply a list, with the full pathnames, of all objects and textures in the model.

Object XYZ gives the position of every object instance in the model.

Materials will present detailed information on every material in the mode.
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1) Request an activation code by clicking the Request activation code button.

2) A form will be presented asking for details about the original order, and should look something like the page shown below. 

3) When all the required details have been entered, hit the request Activation code button and a request will be sent for processing. 

4) You may have to wait 24 hours for the code which will be delivered by email 

5) The code you receive needs to be entered into the Activation code edit box (the green one) and then 3DSimED should be activated with the Activate! 
button.

Any problems try the help page at sim-garage here. 

Support Forum

The fastest way to get assistance is probably through the 3DSimED support forum at The Pits.

Follow this link to access the forum.
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